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What’s New in Pro Tools 12.8.2

New Features and Enhancements
Pro Tools® and Pro Tools HD software version 12.8.2 provides the following new features and enhancements:

MIDI

MIDI Editing Enhancements

Tab to Transient Improvements with MIDI Data

• With Tab to Transients disabled, tab to MIDI clip boundaries in all track views

• With Tab to Transients enabled, tab to MIDI clip boundaries and MIDI notes in all track views

• With Tab to Transients enabled, tab to MIDI CC events in MIDI CC track views and shown controller lanes

Left and Right Arrow Key Navigate MIDI Notes in Notes View

• Move to and select previous (Left Arrow) or next (Right Arrow) MIDI notes in Notes view

Improved Smart Tool Behavior when Editing MIDI Clips

• Move and place end of MIDI clip to Edit Insertion point

• Move and place beginning of MIDI clip to Edit Insertion point

• Duplicate and place end of MIDI clip copy to Edit Insertion point

• Duplicate and place beginning of MIDI clip copy to Edit Insertion point

Grabber Tool Places the Edit Insertion Point at the Nearest Grid Location when in MIDI Notes View and in Grid Mode

This facilitates MIDI editing in Notes view with Grid mode enabled.

Clip Boundaries Shown in MIDI Control Automation Track Views

This provides visual navigation of MIDI clips while editing and arranging MIDI CC data.

MIDI Controller Numbers Shown in Track View and Controller Lane Selectors

This helps to ensure that you are editing the desired MIDI CC data.

Scroll Track Piano Roll with Scroll Wheel or Track Pad

This lets you quickly and easily view the appropriate register when editing MIDI notes.

MIDI Recording Enhancements

MIDI and Instrument Tracks Show Recording Progress

This provides a visual indication of recording progress on the timeline.

Recorded MIDI Clips Automatically Trimmed to the Nearest Barlines Containing All Recorded MIDI Data

This facilitates MIDI clip arranging.

MIDI Merge Release Mode for Improved MIDI CC Merge Recording

This ensures the proper merging of MIDI CC data with multiple record passes.
 What’s New in Pro Tools 12.8.2 1



Record Enable Shown Tracks Button in MIDI Editor Windows

This provides visual indication for record enabled tracks in MIDI Editor windows and also lets you quickly record new MIDI perfor-
mances while working in MIDI Editor windows.

Window Configurations Include MIDI Controller Lanes

New Include MIDI Lanes In Display Settings setting in the Window Configuration dialog lets you choose whether MIDI Editor auto-
mation lanes will be left alone, or replaced with saved ones, when a Window Configuration is recalled.

MIDI Input Display

The Edit window and MIDI Editor windows provide a MIDI Input display that shows notes and chords as they are played on a MIDI 
controller for record enabled MIDI or Instrument tracks or for the specified Default MIDI Thru Instrument.

Miscellaneous Improvements

Batch Renaming for Tracks and Clips

Rename and number selected tracks or clips in batches to manage the names of tracks and clips.

Scroll to Track Names (Rather than Track Numbers)

This lets you quickly scroll to the desired track in the Edit or Mix window.

Dynamic Resizing of the Channels Column in the Bus page in the I/O Setup Dialog to Fit Different Bus 
Channel Formats

This automatically optimizes the use of screen space when working in the I/O Setup.

New Keyboard Shortcuts and Modifiers
• New keyboard shortcuts to adjust grid and nudge size without needing a numeric keypad

• Keyboard shortcut to show or hide the docked MIDI Editor in the Editor window

• Key modifier to switch Pencil Tool between the currently selected Line shape and the Free Hand option

Support for Ambisonics Channel Widths
(Pro Tools HD Only)

• Support for 1st-, 2nd-, and 3rd-Order Ambisonics track, and input, output, and bus path channel formats

• Support for third-party AAX Ambisonics plug-ins

Surround and Dolby Atmos® Updates
(Pro Tools HD Only)

• Front/Rear linking for all surround panners

• Use Dolby Atmos Renderer option in Default menu to create busses based on the currently detected renderer input configuration

• Auto-Height Overrides Height option to automatically re-purpose existing X/Y automation to automatically generate Height pan au-
tomation

• Coalesce Pan Guide Automation command to commit automatically generated Height pan automation
 What’s New in Pro Tools 12.8.2
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System Requirements and Compatibility Information
Avid can only assure compatibility and provide support for hardware and software it has tested and approved. 

For complete system requirements and a list of qualified computers, operating systems, hard drives, and third-party devices, visit:

www.avid.com/compatibility

Conventions Used in This Guide
Pro Tools documentation uses the following conventions to indicate menu choices, keyboard commands, 
and mouse commands:
:

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The following symbols are used to highlight important information:

How to Use this PDF Guide
This PDF provides the following useful features:

• The Bookmarks on the left serve as a continuously visible table of contents. Click on a subject heading to jump to that page.

• Click a + symbol to expand that heading to show subheadings. Click the – symbol to collapse a subheading.

• The Table of Contents provides active links to their pages. Select the hand cursor, allow it to hover over the heading until it turns 
into a finger. Then click to locate to that subject and page.

• All cross references in blue are active links. Click to follow the reference.

• Select Find from the Edit menu to search for a subject.

• When viewing this PDF on an iPad, it is recommended that you open the file using iBooks to take advantage of active links within 
the document. When viewing the PDF in Safari, touch the screen, then touch Open in “iBooks”.

Convention Action

File > Save Choose Save from the File menu

Control+N Hold down the Control key and press the N key

Control-click Hold down the Control key and click the mouse but-
ton

Right-click Click with the right mouse button

User Tips are helpful hints for getting the most from your Pro Tools system.

Important Notices include information that could affect your Pro Tools project data or the performance of your 
Pro Tools system.

Shortcuts show you useful keyboard or mouse shortcuts.

Cross References point to related sections in this guide and other Avid documentation.
 What’s New in Pro Tools 12.8.2
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Resources
The Avid website (www.avid.com) is your best online source for information to help you get the most out of Pro Tools. 

Account Activation and Product Registration
Activate your product to access downloads in your Avid account (or quickly create an account if you do not have one). Register your 
purchase online, download software, updates, documentation, and other resources.

www.avid.com/account

Support and Downloads
Contact Avid Customer Success (technical support), download software updates and the latest online manuals, browse the Compatibil-
ity documents for system requirements, search the online Knowledge Base or join the worldwide Avid user community on the User Con-
ference.

www.avid.com/support

Training and Education
Study on your own using courses available online, find out how you can learn in a classroom setting at an Avid-certified training center, 
or view video tutorials and webinars.

www.avid.com/education

Products and Developers
Learn about Avid products, download demo software, or learn about our Development Partners and their plug-ins, applications, and 
hardware.

www.avid.com/products
 What’s New in Pro Tools 12.8.2
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New MIDI Features and Improvements

MIDI Editing Enhancements

Using Tab to Transients with MIDI Clips and MIDI Events
Tab to Transients works with MIDI clips and MIDI events on MIDI and Instrument tracks much like it does with audio clips and 
audio transients on audio tracks.

Tab to Transients Disabled

When Tab to Transients is disabled, pressing Tab moves the insertion point to the next MIDI clip boundary regardless of the track 
view (just like with audio clips).

Tab to Transients Enabled

When Tab to Transients is enabled, pressing Tab moves the Edit insertion to the beginning of the next note or clip boundary re-
gardless of the track view (just like with audio transients), but does not make note selections.

Insertion point tabbed to next clip boundary on a MIDI track in notes view (Tab to Transients disabled)

Insertion point tabbed to next MIDI event on a MIDI track in notes view (Tab to Transients enabled)

Press Option+Tab (Mac) or Alt+Tab (Windows) to move the insertion point to the previous clip boundary or MIDI note.
 New MIDI Features and Improvements 5



Tabbing to Notes and MIDI CC Events in Notes View with Controller Lanes Shown

When a MIDI or Instrument track is set to Notes view and Tab to Transients is enabled, press the Tab key to move to the next MIDI note 
or MIDI CC event (such as MIDI CC 64 Sustain Pedal) shown in a revealed controller lane. Press Option+Tab (Mac) or Alt+Tab (Win-
dows) to move to the previous note or MIDI event.

Tabbing to MIDI CC Events in MIDI CC Track Views

When a MIDI or Instrument track is set to any MIDI Controller track view and Tab to Transients is enabled, press the Tab key to move 
to the next MIDI event shown in that track view. Press Option+Tab (Mac) or Alt+Tab (Windows) to move to the previous MIDI event.

Hold the Shift key while pressing Tab—or Option+Tab (Mac) or Alt+Tab (Windows)—to move the insertion point and make 
or extend the edit selection. 

Command Focus L and Command Focus “Apostrophe” (‘) function the same as with Option+Tab (Mac) or Alt+Tab (Win-
dows) and Tab with Tab to Transients is enabled or disabled.

In Notes view with MIDI controller lanes shown and Tab to Transients enabled, Tab to move to a MIDI CC event

In Pitch Bend view, moving from one pitch bend event to the next using the Tab to Transients
 New MIDI Features and Improvements
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Navigating MIDI Notes with the Left and Right Arrow Keys

Navigating Notes

In Notes view, use the Left and Right Arrow keys to navigate to and select the previous or the next note.

Selecting Notes

Hold the Shift key while using the Left and Right Arrow keys to extend the note selection.

Navigating and Selecting Notes in Chords

When navigating through chords with the Left and Right Arrow keys, each note in the chord is recognized as a single event. This lets 
you move through each note in the chord, selecting each individually.

In Notes view, moving from one note to the next using the Right Arrow key

For MIDI and Instrument tracks in Notes view where any MIDI Controller lanes shown, the Left and Right Arrow keys only 
navigate through MID notes and skip all MIDI CC events shown in any Controller lane.

In Notes view, selecting notes using the Right Arrow key while holding the Shift key

In Notes view, navigating the notes of a chord with the Right Arrow key
 New MIDI Features and Improvements
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Use the Shift key with the Left and Right Arrow keys to select more than a single note in a chord.

Improved Smart Tool Behavior when Editing MIDI Clips
When editing MIDI clips with the Smart tool, you can position the Smart tool over the lower half of the clip to use the Grabber tool. If 
you position the Smart tool over the lower third of the clip, you can use the Grabber tool with key modifiers to place either the beginning 
of the clip or the end of the clip to the Edit insertion point. You can also do this when duplicating MIDI clips.

To move and place the beginning of a MIDI clip to the Edit insertion point:

1 Set the Edit insertion point to the location you want.

2 With the Smart tool, position the cursor over the lower third of the clip. The Grabber tool cursor appears.

3 Control-click (Mac) or Start-click (Windows) and drag the clip toward the Edit insertion and release the mouse.

The beginning of the clip snaps to the Edit insertion point.

In Notes view, selecting the notes of a chord using the Right Arrow key while holding the Shift key

Snapping the beginning of a MIDI clip to Insertion point with the Smart tool
 New MIDI Features and Improvements
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To duplicate a MIDI clip and have the copy start at the Edit insertion point:

1 Set the Edit insertion point to the location you want.

2 With the Smart tool, position the cursor over the lower third of the clip you want to duplicate and place. The Grabber tool cursor ap-
pears.

3 Option-Control-click (Mac) or Alt-Start-click (Windows) and drag the clip toward the Edit insertion and release the mouse.

The duplicate of the clip starts at the Edit insertion point.

To move and place the end of a MIDI clip to the Edit insertion point:

1 Set the Edit insertion point to the location you want.

2 With the Smart tool, position the cursor over the lower third of the clip. The Grabber tool cursor appears.

3 Command-Control-click (Mac) or Control-Start-click (Windows) and drag the clip toward the Edit insertion and release the mouse.

The end of the clip snaps to the Edit insertion point.

To duplicate a MIDI clip and have the copy end at the Edit insertion point:

1 Set the Edit insertion point to the location you want.

2 With the Smart tool, position the cursor over the lower third of the clip you want to duplicate and place. The Grabber tool cursor ap-
pears.

3 Command-Option-Control-click (Mac) or Control-Alt-Start-click (Windows) and drag the clip toward the Edit insertion and release 
the mouse.

The duplicate of the clip ends at the Edit insertion point.

Snapping the end of a MIDI clip to Insertion point with the Smart tool
 New MIDI Features and Improvements
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Grabber Tool Places the Edit Insertion Point at the Nearest Grid Location when in 
MIDI Notes View and in Grid Mode
When in Grid mode and in Notes view on MIDI and Instrument tracks, clicking anywhere in the timeline outside of a clip with the 
Grabber tool places the Edit insertion point at the nearest grid location.

Clip Boundaries Shown in MIDI Control Automation Track Views
When working on Instrument and MIDI tracks in any MIDI Controller Automation view (such as Velocity, Pitch Bend, or Mod Wheel) 
Clip boundaries are displayed. This provides context for note and MIDI Controller data visible on the track as you are editing. MIDI clip 
boundaries are also shown in MIDI Editor windows. This is useful for navigating various MIDI views when editing and arranging MIDI 
clips and MIDI data.

MIDI Controller Numbers Shown in Track View and Controller Lane Selectors
MIDI Continuous Controller (CC) numbers are shown in parenthesis in the Track View and Controller Lane selectors. Aside from com-
mon controller number assignments like “Mod Wheel” (1), “Volume” (7), or “Sustain Pedal” (64), many MIDI continuous controllers 
are simply “unassigned” in the standard MIDI specification. This can be confusing if you are editing data for several “unassigned” or 
otherwise generic continuous controllers, so by having the controller number always shown next to the name in parenthesis, you can eas-
ily see which continuous controller you are editing.

Press Command (Mac) or Control (Windows) while clicking with the Grabber tool in notes view temporarily toggle to Slip mode.

Clip boundaries shown around MDI control data in Mod Wheel Track view

MIDI CC numbers shown in Track View and Controller Lane selectors (in addition to the standard name, if any)
 New MIDI Features and Improvements
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Scroll Track Piano Roll with Scroll Wheel or Track Pad
Use the scroll wheel on your mouse or the track pad on your laptop to scroll the piano roll up or down on a MIDI or Instrument track 
to view the note range you want to work with. This is a quick and easy way to focus the track on the right register for note editing. 

To scroll the piano roll of a MIDI or Instrument track up or down:

1 In the Edit window, position the cursor over the piano roll of the MIDI or Instrument track you are working with. 

2 Use the scroll wheel or track pad (two-finger scroll) to scroll up or down until you locate the register you want.

MIDI Recording Improvements

MIDI and Instrument Tracks Show Recording Progress
When recording MIDI on a MIDI or Instrument track, Pro Tools displays an advancing red clip to indicate recording progress against 
the timeline (just as when recording audio on an audio track).

Scroll piano roll up or down with the scroll wheel or track pad

Recording progress indicated on an Instrument track
 New MIDI Features and Improvements
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Recorded MIDI Clips Automatically Trimmed to the Nearest Barlines
When recording MIDI to a MIDI or Instrument track, the resulting clip is trimmed to the nearest bar line. The new clip contains all re-
corded MIDI data and automatically adjusts its start and end points to fit into the fewest number of whole bars for the recorded perfor-
mance. This facilitates bar-based editing and arranging with recorded MIDI clips.

MIDI Merge Release Mode
MIDI Merge Release Mode provides three options for how Pro Tools writes MIDI Continuous Controller (CC) automation when re-
cording MIDI in MIDI Merge mode. Select the desired MIDI Merge Release Mode option in the Pro Tools MIDI Preferences or from 
the Right-click menu on the MIDI Merge button:

Latch Continues writing the last value. Any existing events are overwritten until you stop recording.

Latch Until Next Event Continues writing the last value until the next event even if you are still recording.

Touch Immediately stops writing any new values (only use this mode to add pedal-based control data, not to modify existing data).

To set the MIDI Merge Release Mode preference:

1 Choose Settings > Preferences.

2 Click the MIDI tab.

3 Select the desired option from the MIDI Merge Release Mode selector.

Recorded MIDI clip fits to nearest whole bars based on first and last recorded MIDI events

MIDI preferences, MIDI Merge Release Mode setting

1. Start recording

2. Recording

3. Recorded
 New MIDI Features and Improvements
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To set the MIDI Merge Release Mode in the Edit window or the Transport window:

1 Ensure that the MIDI Controls are shown.

2 Right-click the MIDI Merge button and select the desired option.

Record Enable for Tracks Shown in MIDI Editor Windows
In addition to the Mute and Solo Shown Tracks buttons, MIDI Editor windows now provide a Record Enable Shown Tracks button. 
When selected, all shown tracks are record enabled (and when deselected, all shown tracks are record disabled).

To record enable all shown tracks in a MIDI Editor window:

 Click the Record Enable Shown Tracks button in the upper-left corner of the MIDI Editor window so that it turns red.

MIDI Merge button Right-click menu

MIDI Editor window, Tracks Record Enable button

Docked MIDI Editor window, Tracks Record Enable button selected
 New MIDI Features and Improvements
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To record disable all shown tracks in a MIDI Editor window:

 Click the Record Enable Shown Tracks button in the upper-left corner of the MIDI Editor window so that it turns grey.

When only some, but not all, of the tracks shown in the MIDI Editor window are record enabled, the Record Enable Shown Tracks but-
ton is grey outlined in red.

Docked MIDI Editor window, Tracks Record Enable button outlined red to indicated that only some shown tracks are record enabled
 New MIDI Features and Improvements
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Window Configurations Include MIDI Editor Window MIDI Automation Lane 
Layouts
Window Configurations provide the option to Include MIDI Lanes In Display Settings. When enabled, the Window Configuration 
stores the layout of MIDI Automation Lanes in MIDI Editor windows, whether docked in the Edit window or when open as a separate 
window. Any Window Configuration that includes MIDI Lanes in Display Settings will recall that exact window and MIDI Automation 
Lane layout.

To create Window Configuration that includes MIDI controller lanes in the display settings for MIDI Editor windows:

1 Configure any MIDI Editor window with MIDI Automation Lanes shown and assigned as you wish.

2 Choose Window > Configuration > New Configuration.

3 Enable the Include MIDI Lanes in Display Settings option.

4 Configure the rest of the New Window Configuration dialog as desired and click OK.

To recall a Window Configuration that includes MIDI controller lanes displayed in a MIDI Editor window:

1 Make any changes to the window layout of your Pro Tools session or project, including collapsing MIDI controller lanes in MIDI Ed-
itor windows or closing a MIDI Editor window.

2 Choose Window > Configurations > Window Configuration List.

3 Click the Window Configuration in the list that includes MIDI controller lanes displayed in a MIDI Editor window.

The window layout of the session or project is restored with MIDI controller lanes shown and assigned in MIDI Editor windows as be-
fore.

New Window Configuration dialog, Include MIDI Lanes in Display Settings option enabled
 New MIDI Features and Improvements
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MIDI Input Display in the Edit Window and MIDI Editor Windows
The MIDI Input display shows note and chord names as they are received by tracks shown in MIDI Editor windows. For example, when 
an Instrument or MIDI track is record-enabled and a MIDI controller is assigned to its Input, note names and recognized chords are dis-
played as you play your controller. Similarly, the MIDI Input display in the Edit window shows chord names (but not notes) when 
chords are recognized at the input of a MIDI or Instrument track.

Note names are displayed as the note letter name and register number (for example, C3 or C4) or as the MIDI note number (for example, 
60) according to the specified Note Display option in the Pro Tools MIDI Preferences (Setup > Preferences > MIDI).

To show (or hide) the MIDI Input display in the Edit window, do one of the following:

• Select (or deselect) View > Other Displays > MIDI Input Display.

• Click the Edit Window Toolbar menu and select (or deselect) MIDI Input Display.

Display of a single note being played

Display of a known chord being played

Display of several notes being played simultaneously that Pro Tools does not recognize as a chord

MIDI Input Display selected in Edit Window Toolbar menu

Editor Window toolbar, MIDI Input Display shows that a G augmented chord is received at an Instrument or MIDI track input
 New MIDI Features and Improvements
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To show (or hide) the MIDI Input display in a MIDI Editor window:

1 Click the MIDI Editor Window menu or Right-click anywhere in the MIDI Editor window toolbar.

2 Select (or deselect) MIDI Input Display.

MIDI Input Display selected in MIDI Editor Window menu

MIDI Editor Window toolbar, MIDI Input Display shows that a G7sus4 chord is received at the track input
 New MIDI Features and Improvements
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Miscellaneous Improvements

Batch Renaming Tracks and Clips
Pro Tools lets you rename selected tracks or clips in batches. This can be very useful for managing auto-named tracks and clips, 
especially in a large session.

Batch Renaming Dialog Options and Settings
The Batch Track Renaming and Batch Clip Renaming dialogs provide controls for changing the names of all selected items (tracks 
or clips) by Replacing text, Trimming characters, Adding characters, and sequential Numbering. The Batch Clip Renaming dialog 
also provides controls for setting the order for numbering selected clips based on timeline order or Clips List sort order. Both dia-
logs also offer presets so you can store and recall common renaming schemes best suited to your workflow.

Replace

Enable (or disable) the Replace option to replace text in the names of clips or tracks.

Find Type the text you want replaced in the names of selected items.

Replace Type the text you want to use in the names of selected items instead.

Clear Existing Name Enable to completely clear the existing names of selected items.

Regular Expressions Enable to use advanced find and replace operations using regular expressions.

Renaming tasks are applied in order from top to bottom: Replace, then Trim, then Add, and finally Numbering.

Press Command+R (Mac) or Control+R (Windows) to select (or deselect) Replace.

Batch Rename, Replace options

For more information about using regular expressions for batch renaming tasks, see Regular Expressions Workflow 
Examples.
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Trim

Enable (or disable) the Trim option to remove the specified number of characters from the beginning or end of names.

From Beginning Enter the number of characters you want to trim from the beginning of the names of selected items.

From End Enter the number of characters you want to trim from the end of the names of selected items.

Range Enable Range and then enter the number of characters From the beginning and the number of character To the end of the range 
that you want to trim (or crop) the selected names to. The From and To values can be counted from the beginning or from the end of the 
selected names.

Count From Beginning Enable to count the From and To values for Range from the beginning of the selected names.

Count From End Enable to count the From and To values for Range from the end of the selected names.

Add

Enable (or disable) the Add option to add prefixes or suffixes to names. You can also insert text into the middle of names.

Prefix Enable the Prefix option and type the text you want to add to the names of selected items as a prefix.

Insert Enable the Insert option and type the text you want to insert into the names of selected items. Enter a number in the At Index field 
to specify after which character you want to insert the text (for example, type 3 to insert text after the third character in names).

Suffix Enable the Suffix option and type the text you want to add to the names of selected items as a suffix.

Press Command+T (Mac) or Control+T (Windows) to select (or deselect) Replace.

Batch Rename, Trim options

Press Command+D (Mac) or Control+D (Windows) to select (or deselect) Add.

Batch Rename, Add options
 Miscellaneous Improvements
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Numbering

Enable (or disable) the Numbering option to add numbers to the names of selected items.

Position Select whether you want numbers to be added at the Beginning or End of names, or at the specified character index (At Index) 
in names. If you select At Index, also enter a number in the Index field to specify after which character in names you want to insert the 
numbers.

Starting Number Enter the number from which you want to start. 

Number of Places Enter the number of places you want for numbering (for example, type 3 for three places 000).

Increment Enter the value by which you want the numbering to increment.

Separate With Enable to separate added numbers with a space or any other single character after (if placed at the beginning) or before 
(if placed at the end), or before and after the specified character index (if inserted at the specified index).

Use A.Z Enable to use capital letters instead of numbers.

Process Order
(Batch Clips Renaming Only)

The Process Order options are only in the Batch Clips Rename dialog and determine the order by which numbering is applied to selected 
clips.

Timeline Order (Left to Right, Top to Bottom) Applies numbering according to the timeline order of selected clips from left to right and 
then from top to bottom.

Clips List Sort Order Applies number according to the current Clips List sort order for selected clips.

Press Command+N (Mac) or Control+N (Windows) to select (or deselect) Numbering.

Batch Rename, Numbering options

Batch Clips Rename, Process Order
 Miscellaneous Improvements
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Presets

Pro Tools lets you store and recall common renaming schemes best suited to your workflow in both the Batch Track Renaming and 
Batch Clip Renaming dialogs. The Presets controls for Batch Renaming work much like the Preset controls for Fades and Clip Effects. 

Presets Buttons

Both the Batch Track Renaming dialog and the Batch Clip Renaming dialog provide five preset buttons that let you store and recall your 
most commonly naming conventions. You save and import addition Batch Naming settings using the Librarian menu.

To store a Batch Naming preset:

1 Configure the Batch Naming dialog as you like.

2 Command-click (Mac) or Control-click (Windows) the Preset button where you want to store the current Batch Naming settings.

To recall a Batch Naming preset:

 Click the Preset button that contains the settings you want to recall.

Librarian Menu

Use the Librarian menu to save and recall Batch Naming Settings files (.ptpreset). These are usually saved to and recalled from the Batch 
Track Rename folder or the Batch Clip Rename folder accordingly (/Documents/Pro Tools/Pro Tools Presets/Batch Track Rename/). 
Of course you can save to and import from any directory location on your system. Batch Name preset files can be shared and used on 
any other Pro Tools system as well.

The Librarian menu commands include:

<factory default> Restores the default settings for Batch Naming.

Save Settings Saves the current settings. This command overwrites any previous version of the preset. 

Save Settings As Saves the current settings as a new preset. You can name the preset and save it to any location on your system.

Import Settings Opens the Choose a Settings File dialog focused on the default Batch Rename folder. Batch Naming Settings files (.pt-
preset) stored in this location are listed by name just under <factory default> in the Librarian menu. In the Choose a Settings File dialog, 
you can navigate to any location on your system to select and import the Batch Settings file you want.

Delete Current Settings File Permanently deletes the current settings file (.ptpreset) from disk.

Lock (Unlock) Settings File Locks (or unlocks) the selected Settings file so that it cannot (or can) be edited.

Batch Rename Presets, Librarian menu shown

Press Command+Shift+S (Mac) or Control+Shift+S (Windows) to save the current Clip Effects settings.
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Batch Track Renaming
The Batch Rename command for tracks is only available in the Track Name Right-click menu.

To rename selected tracks in batches:

1 Select the tracks you want to rename.

2 Right-click any selected track name in the Tracks List, Edit window, Mix window, Score Editor window, or a MIDI Editor window.

3 Choose Batch Rename.

4 Configure the Batch Track Rename dialog as desired.

5 Click OK.

All selected tracks are renamed accordingly.

Press Option+Shift+R (Mac) or Alt+Shift+R (Windows) to open the Batch Track Rename dialog.

Batch Track Rename dialog
 Miscellaneous Improvements
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Batch Clip Renaming
The Batch Rename command for clips is only available in the Clips List.

To batch rename selected clips:

1 In the Clips List, select the clips you want to rename.

2 Do one of the following:

• Click the Clip List menu.

• Right-click a selected Clip in the Clips List.

3 Choose Batch Rename.

4 Configure the Batch Clip Rename dialog as desired.

5 Click OK.

All selected clips are renamed accordingly.

Clip Groups and clips contained within are ignored by Batch Clip Renaming.

Press Control+Shift+R (Mac) or Start+Shift+R (Windows) to open the Batch Clip Rename dialog.

Batch Clip Rename dialog
 Miscellaneous Improvements
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Regular Expressions Workflow Examples
Regular expressions are standardized text strings that describe search patterns. Use regular expressions when batch renaming tracks or 
clips to find and replace text based on more advanced criteria than simple find and replace text operations. 

Performing Multiple Find and Replace Commands

With Regular Expressions enabled, any number of text patterns can be matched and replaced when batch renaming tracks or clips. In 
the Find field, type the pattern you want to match inside parentheses and then separate patterns using | (the pipe symbol). For example:

The text following ?1 will replace the text Audio, the text following ?2 will replace VCA, and the text following ?3 will replace 
Aux—(?1Aud)(?2Group Master)(?Bus)

Removing Automatic Names Generated By Track Duplication

Use the following regular expressions to remove all instances of .dup1, .dup2, or up to any number of duplicates from track or clip names 
by replacing them with no character at all.

\. searches for literal periods—as opposed to the special token . (period) since . itself is used to match any character—followed by dup, 
then \d (the regular expression for any number) followed by + (which matches any number of digits that follow .dup) and replaces all 
matches with nothing (effectively deleting that text). 

For more information about regular expressions, visit https://www.regex101.com.

Some commonly used regular expressions for advanced find and replace text operations:

regular expressions function

. Matches any single character.

\ - \ Lets the character following the second \ be considered differently. For example, since . 
(period) is used to match any character, type \. to match an actual . (period) in a search string.

\s Matches any instance of a single space (such as the space bar or tab).

\d Matches a single number.

\w Matches a single “word character” or letter.

+ Any of the above regular expressions or any literal character can be followed with + to match 
one or more of the preceding characters (for example, \w+ can be used to find any number of 
spaces created by the spacebar or tab).

[abc] Match a single instance of a, b, or c.

[^abc] Match any character except a, b, or c.

find replace

(Audio)|(VCA)|(Aux) (?1)(?2)(?3)

find replace

\.dup\d+
 Miscellaneous Improvements

24

https://www.regex101.com


Replacing Multiple Common AudioSuite Suffixes from Clip Names 

Use the following regular expressions to find text automatically added by common AudioSuite processes and remove them or replace 
them with something more appropriately descriptive.

This replaces -Norm with nothing (effectively deleting that text), and replaces -EQ3-1B with -HPF to indicate that the EQ3-1B Audio-
Suite processing on the selected clips was used to roll off low frequencies.

Scroll to Track by Name
The Scroll to Track dialog lets you type the name of the track you want to scroll to. Also, as you type a track name, only those tracks 
whose names begin with the letter you enter appear in the scroll to track list. 

To scroll to a track in the Edit or Mix window:

1 Choose Track > Scroll to Track.

2 In the Scroll to Track dialog, type the first few letters of the track name you want to scroll to.

3 From the Scroll to Track list, select the track name you want to scroll to using the Up and Down Arrow keys.

4 Press Return (Mac) or Enter (Windows), or click OK.

The specified track is selected and scrolled into view.

find replace

(-Norm)|(-EQ3-1B) (?1)(?2-HPF)

In previous versions of Pro Tools you could only scroll to a track by its track number.

Press Command+Option+F (Mac) or Control+Alt+F (windows) to open the Scroll to Track dialog.

Scroll to Track dialog
 Miscellaneous Improvements
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Dynamic Resizing of the Channels Column in the Bus Page of the I/O Setup 
Dialog to Fit Different Bus Channel Formats
The Channels column in the Bus page of I/O Setup dialog automatically resizes to fit the width of the bus with the greatest number of 
channels. This aids the visual navigation of the bus page when changing (adding, deleting, or editing) bus channel formats.

Bus page of I/O Setup, Channels column resizes automatically based on the greatest bus channel width
 Miscellaneous Improvements
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New Keyboard Shortcuts and Modifiers

Adjusting Grid and Nudge on Keyboards with No Keypad
Use the following keyboard shortcuts to adjust the grid and nudge values on any computer keyboard (such as laptop computers):

To increase the grid value:

 Press Shift+Equal (=)

To decrease the grid value:

 Press Shift+Minus (–)

To increase the nudge value:

 Press Shift+Option+Equal (=) (Mac) or Shift+Alt+Equal (=) (Windows)

To decrease the nudge value:

 Press Shift+Option+Minus (–) (Mac) or Shift+Alt+Minus (–) (Windows)

Keyboard Shortcut to Show/Hide the Docked MIDI Editor
Pro Tools lets you show or hide the MIDI Editor docked in the Edit window with a keyboard shortcut.

To show or hide the docked MIDI Editor in the Edit window:

 Press Shift+Option+Control+“=” (Mac) or Shift+Alt+Start+“=” (Windows).

Key Modifier to Switch Pencil Tool Between Selected Line Shape and Free Hand 
Options
When editing automation or MIDI control data with the Pencil tool, you can switch between the current Pencil Tool shape (such as Line) 
and Free Hand pencil editing using a key modifier: the Command key (Mac) or the Control key (Windows). When editing with the se-
lected Pencil shape, the Pencil cursor angles to the left. When editing in Free Hand with the key modifier, the Pencil cursor angles to 
the right.

To temporarily switch to Free Hand editing with the Pencil tool:

 Press the Command key (Mac) or the Control key (Windows) while editing with the Pencil Tool.

Release the key modifier to switch back to editing with the selected Pencil shape.

Editing with Triangle Pencil tool (left), editing in Free Hand using key modifier (right)
 Miscellaneous Improvements
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Support for 1st-, 2nd-, and 3rd-Order 
Ambisonics Channel Formats
(Pro Tools HD Only)

Pro Tools | HD software provides support for 1st-, 2nd-, and 3rd-Order Ambisonics channel formats (4-, 9-, and 16-channel formats 
respectively). Import Ambisonics audio recordings, record Ambisonics audio in Pro Tools using Ambisonics miking techniques, 
or use supported 3rd-party AAX Ambisonics panning, and encoding and decoding plug-ins to create your own Ambisonics mixes 
from source audio tracks.

What is Ambisonics?
Ambisonics is a “full-sphere” surround sound technique that is capable of representing sound sources that are stationary or in mo-
tion, and at variable distances from above, below, and all around the listener. More interestingly though, higher order Ambisonics 
can represent sound sources that seem to remain fixed in a sound field while the listener’s perspective changes with their head po-
sition (as opposed to “head-locked” stereo mixes). Ambisonics audio mixes are used for 3D audio in virtual reality and gaming ap-
plications, as well as 360 video. However, the possibilities for Ambisonics are only just beginning to be explored commercially.

1st Order Ambisonics correspond to physical microphone pickup patterns using an omni-directional microphone in conjunction 
with figure-eight capsules oriented along three spatial axes. Miking for 1st Order Ambisonics is a three-dimensional extension of 
common Mid/Side stereo (M/S) miking techniques that adds additional difference channels for height and depth. This results in 
B-format audio (WXYZ), or 1st Order Ambisonics, which consists of four discrete audio channels: W for sound pressure (omni-di-
rectional—the M in M/S), X for the front-minus-back sound pressure gradient, Y for left-minus-right (the S in M/S), and Z for 
up-minus-down.

1st Order Ambisonics is most commonly used for horizontal-only surround because of positional errors and shading effects that re-
sult from adding a fourth microphone. Higher-order Ambisonics provide greater positional resolution of sound sources in the sound 
field. Higher-order difference signals are derived from several spatially distributed (usually omni-directional) capsules using so-
phisticated digital signal processing. Higher-order Ambisonics can also be rendered from channel-based audio recordings (such as 
mono and stereo) strictly using Ambisonics plug-in processing in Pro Tools.

Configuring the I/O Setup for Ambisonics
Pro Tools lets you create 1st-, 2nd-, and 3rd-Order Ambisonics input, output, and bus paths. Typically, you will only need to create 
bus paths in Ambisonics formats for most Ambisonics mixing workflows. Create Ambisonics Input paths if you will be recording 
Ambisonics right into Pro Tools using Ambisonics miking techniques (using specially configured microphone arrays or specialized 
commercially available Ambisonics microphones). It is unlikely that you would ever need to create Ambisonics Output paths un-
less you are playing back Ambisonics from one Pro Tools system and recording it on another Pro Tools system or using another 
system to decode Ambisonics audio.

To create an Ambisonics bus path:

1 Choose Setup > I/O and click the Bus tab.

2 Click the New Path button.

3 Create the busses that you need with the desired Ambisonics format.
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4 Click Create.

5 Click OK to close the I/O Setup.

Channel Ordering for Ambisonics Audio Signal Paths
Ambisonics formats use discrete channel orderings that are distinct from channel-based surround formats (such as 5.1). In Pro Tools, the 
individual channels of all Ambisonics formats are numbered from left to right in the I/O Setup starting with 00 (or W in B-format) and 
increase incrementally. For example, the individual channels for 1st Order Ambisonics are 00, 01, 02, 03 (WXYZ); and for 2nd Order 
Ambisonics are 00, 01, 02, 03, 04, 05, 06, 07, 08.

The individual channels of Ambisonics formats do not correspond to speaker signal mappings like other surround formats (such as 
5.1—L C R Ls Rs LFE). In most cases, use Ambisonics panning, encoder and decoder plug-ins to accurately mix and monitor Ambi-
sonics mixes over headphones. However, even though Ambisonics formats do not directly map to common channel-based surround 
speaker configurations, various alternate speaker configurations can be used for the playback of Ambisonics mixes.

Selecting 1st Order Ambisonics as the format for a new bus path

Ambisonics bus paths with standard channel orders in the I/O Setup

Do not use multi-mono plug-ins following any Ambisonics plug-ins. Likewise, any plug-in processing of source tracks should 
only be inserted before Ambisonics plug-ins. 
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Ambisonics Mixes in Pro Tools
Creating Ambisonics mixes in Pro Tools usually entails using Avid-qualified third-party AAX Ambisonics panning plug-ins on source 
audio tracks and routing the output of those tracks to an Auxiliary Input track with an Ambisonics format–to-stereo plug-in for head-
phone monitoring. Ambisonics mixing workflows and configurations vary depending on the source material, specific Ambisonics 
plug-ins used, and required delivery formats. 

Example—configuring Pro Tools to mix from a mono source audio track to a 2nd Order Ambisonics stereo mix using FB360 Audio 
plug-ins:

1 Ensure that the I/O Setup is configured with a 2nd Order Ambisonics bus path (see Configuring the I/O Setup for Ambisonics).

2 Create a mono audio track with audio you want to mix to 2nd Order Ambisonics.

3 Assign the Output of the track to the 2nd Order Ambisonics bus path.

4 Insert the FB360 Spatialiser plug-in on the track (if you want to process the audio with other plug-ins on the track, they must precede 
the Ambisonics plug-in).

5 Create a 2nd Order Ambisonics Auxiliary Input track.

6 Assign the 2nd Order Ambisonics bus path to the Input of the Auxiliary Input track.

7 Insert the FB360 Control plug-in on the Auxiliary Input track.

Mono audio mixed in 2nd Order Ambisonics to stereo for headphone monitoring

Depending on the Ambisonics panning plug-in you are using, source audio tracks can be mono or stereo, or even surround 
formats (such as 5.0 or 7.0) or Ambisonics formats (such as B-format).

Repeat steps 3–5 to create additional source tracks for the Ambisonics mix.
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8 Assign the Output of the Auxiliary Input track to the main stereo output of your audio interface for headphone monitoring.

9 Automate panning of mono source to 2nd Order Ambisonics with the FB360 Spatialiser plug-in.

10 Playback and monitor Ambisonics mix over headphones.

In order to avoid coloring the audio projected from speakers with the room ambiance, Ambisonics mixes are typically mon-
itored over headphones.

Ambisonics panning, encoding and decoding plug-ins typically change the track channel width (such as mono to 2nd Order 
Ambisonics). It is important to know that for some Ambisonics plug-ins that change track channel widths you must first create 
the track with the appropriate channel format (such as mono source or 2nd Order Ambisonics input) and then assign the ap-
propriate track output (such as mono to 2nd Order Ambisonics) before you can insert the appropriate Ambisonics plug-in.

Clip effects editing is not supported for clips on Ambisonics tracks. When a timeline selection is made that includes clips from both 
Ambisonics and non-Ambisonics tracks, only clips on non-Ambisonics tracks are processed by clip effects. If clip effects are ap-
plied to one or more clips on a non-Ambisonics track and then dragged-and-dropped to an Ambisonics track, clip effects process-
ing of those clips play back, but clip effects for these clips cannot be edited until they are moved back to a non-Ambisonics track.
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Surround and Dolby Atmos Updates
(Pro Tools HD Only)

Front/Rear Linking for All Surround Panners
Pro Tools surround panners provide separate controls for positioning the sound source left/right in the front versus left/right in the 
rear. The Front and Rear left/right positions controls can be linked or unlinked (they are linked by default). When linked the F/R 
control pans the signal front to back always along the same left/right path. When unlinked, you can pan front to back diagonally 
according to independent Front and Rear settings.

To Unlink (or relink) the Front and Rear Position controls in a Pro Tools Surround Panner:

1 Open a mono (or stereo) track Output or Send window that is assigned to an LCRS surround path or greater.

2 Click the green (lit) Link icon for the Front and Rear Position controls so that it is unlit (or lit to link them).

I/O Setup Default Dolby Atmos Renderer Option for Busses
If you are mixing for Dolby Atmos, use the Use Atmos Renderer option for Default Busses to automatically create Internal and 
Output busses based on the configuration of the Dolby Atmos Renderer. Pro Tools automatically creates the correct number of 
paths, each with the correct channel format for all beds and objects in the renderer’s configuration, and Object busses are automat-
ically mapped to the corresponding Object ID.

To automatically create busses in Pro Tools that match the Dolby Atmos Renderer configuration:

1 Configure the Dolby Atmos Renderer.

2 In Pro Tools, ensure that Dolby Atmos is enabled (Setup > Peripherals > Atmos).

3 Open the I/O Setup (Setup > I/O) and click the Bus tab.

4 Delete any existing busses.

5 From the Default Busses selector, enable the Use Atmos Renderer option.

6 Click the Default button.

7 Click OK.

Front and Rear positions linked (left) versus Front and Rear positions unlinked (right)

I/O Setup, Bus tab: Default All Busses selector
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Auto-Height Overrides Height Automation Option
With multichannel panning automation, Pro Tools lets you re-purpose existing Front, Rear, and Front/Rear pan automation for Height 
automation when mixing to Dolby Atmos (7.0.2 or 7.1.2). When this option is enabled, the selected auto-height mode overrides any 
Height automation, generating new height automation automatically. This way you don’t have to re-write all new automation when 
opening existing 5.1 or 7.1 sessions and re-mixing them for Dolby Atmos (7.0.2 or 7.1.2 panning).

To enable (or disable) Auto-Height Overrides Height Automation:

1 Open the Output window for the track you want.

2 Do one of the following:

• Double-click the Height Mode selector.

• Right-click the Height Mode selector and select (or deselect) Auto-Height Overrides Height Automation.

Coalesce Pan Glide Automation
When using the Auto-Height Overrides Height Automation option to automatically generate Height automation, you can commit that 
automation using the Coalesce Pan Glide Automation command. Committed Height automation is calculated by interpolating Front, 
Rear, and Front/Rear pan automation, and the selected Auto-Height mode.

To automatically generate Height automation from Front, Rear, and Front/Rear pan automation, and the selected Auto-Height mode for 
one or more tracks:

1 Select the tracks for which you want to generate Height automation.

2 Choose Edit > Automation > Coalesce Pan Glide Automation.

The Auto-Height Overrides Height Automation option defaults to on if the track already has a main output assignment prior 
to assigning an object output (assuming a re-use workflow). This option defaults to off when translating automation from the 
Dolby Atmos Panner plug-in and also when a track has an object output assigned but no main output assigned.

To commit automatically generated height automation, use the Coalesce Pan Glide Automation command. See Coalesce 
Pan Glide Automation.

Right-clicking Height mode to select Auto-height Overwrite Height Automation

When exchanging Pro Tools HD 12.8.2 sessions that use Auto-Height Overrides Height Automation with Pro Tools HD 12.8 
or 12.8.1 systems, be sure to Coalesce Pan Glide Automation first so that Height Pan Automations plays back correctly.
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